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1 .  I n t r o d u c t i o n  &  I n s t a l l a t i o n

Working Model - Fast and Powerful 
Engineering Analysis for Desktop PC’s 
Working Model is a powerful tool for engineering analysis, 
animation, and prototyping. It saves time and money in the design 
process by allowing you to create and analyze dynamic physical 
systems on the computer prior to building costly prototypes. 

Operating 
Concept

The operating concept of Working Model is straight-forward. 
First, define a set of rigid bodies and constraints (e.g., motors, 
springs, and joints) by drawing them with a mouse. Then set your 
system into motion by selecting “RUN” -- there is no pre-
processing or post-processing. You immediately receive accurate 
results.

With Working Model, you create systems that are driven by 
physical laws. You can test, re-design, and re-test your 
mechanical system, speeding your time to market by seeing which 
designs work better before you build them.

Working Model allows you to fine-tune simulation parameters. 
You can define controllers to adjust properties of objects. You can 
create meters to plot the data that is taken during a simulation. 
You can design a model in your CAD program and import the 
data into Working Model. You can even use another application 
such as Excel or MATLAB®  to control your simulations.

Designed with 
Ease -of-Use in 
Mind

Working Model was designed to be an integral tool in the design 
and analysis process for engineers of all types. Its highly intuitive 
interface makes it useful for engineers of all levels. An engineer 
can quickly test the performance of a shock absorber with a 
simple model, or create a highly complex dynamic model of an 
automobile engine. With its high degree of accuracy, Working 
Model can simulate almost any mechanical system.

Parametrics Use equations to define the relationships among components of 
your design.  When you re-position or re-size components, your 
design maintains the connections, sizing, and positions specified 
by your equations.

Smart Editor ™ Working Model features the unique Smart Editor™. The Smart 
Editor shortens the design process by making it extremely easy to 
build and maintain complex designs as well as check for 
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clearances, mechanism functionality, and tolerances. 
Interconnected objects can be moved by simply clicking and 
dragging—the Smart Editor automatically moves each object 
based on existing constraints. 

Import / Export Working Model includes import/export options. With Working 
Model, users can import CAD drawings in DXF format from 
popular applications such as AutoCAD®, CADKEY and 
Vellum® and use them immediately in simulations.

Inter-Application 
Communication

Working Model uses Dynamic Data Exchange (DDE) on 
Windows and Apple® Events on Macintosh to communicate with 
other applications during a simulation.   With this feature, users 
can specify physical models of real-life mechanical designs and 
then control them externally through other programs.   For 
example, Microsoft® Excel can be used to calculate control 
signals.   Data from Working Model is sent to the spreadsheet 
which calculates the control signals based on the current state of 
the system. New control information is then received by Working 
Model and used to calculate the next simulation frame.

About the Demonstration Version
These demonstration disks include a limited version of Working 
Model along with numerous example files. You will be able to 
build parametric models, simulate their behavior, make 
measurements and interact with systems using the Smart 
Editor™. 

Several features, however, have been disabled in the 
demonstration version. In particular, file saving functionality has 
been removed (Save, Save As, Print, Export, Cut, Copy, Paste and 
Duplicate). This version also limits the number of measurements 
and bodies that can be created to one meter and five bodies per 
document.

The Demonstration Guide & Tutorial
This guide will provide you with information you will need to 
evaluate Working Model. It contains a 10 Minute Demo, two 
tutorials, and reference information on Working Model’s tool 
palette, function language, and parametrics.
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System Requirements
Working Model versions are available for both Macintosh and 
Windows personal computers. The following system 
configurations are needed to run Working Model:

Windows: A 486 microprocessor or better is required, Windows 
version 3.1 or greater, 16 megabytes of RAM is strongly 
recommended (8 megabytes of RAM will require virtual memory 
and will slow simulations considerably) and 12 megabytes of 
available hard disk space. 

Macintosh: A 68020-based computer or higher (Mac II or above) 
is required. Macintosh Plus, SE, Portable, Classic and Powerbook 
100 are not supported. Working Model requires System 7 or later, 
approximately 10 megabytes of RAM and 8 megabytes of 
available hard drive space. A floating-point math co-processor is 
highly recommended. Working Model is compatible with 
PowerPC-based Macintosh computers.

Installation
The demonstration disk contains an automatic installer. To install:

On Macintosh: simply double-click on the icon named Double-
Click Me to Install.

On Windows: run SETUP from within Windows.

Ordering Information
We hope you enjoy the demonstration version. To order your full 
copy of Working Model:

• contact your local authorized reseller,

• call Knowledge Revolution TOLL-FREE at (800) 766-6615 or 

(415) 574-7777 (8:00AM to 5:00PM Pacific Time),

• e-mail us (internet) via info@krev.com, or
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• print out the order form in the README file included on the 
demonstration disks and fax or mail it to Knowledge 
Revolution at:

FAX: (415) 574-7541
MAIL: Knowledge Revolution

66 Bovet Road, Suite 200
San Mateo, CA 94402

Working Model comes with a 30-day money-back guarantee!



Working Model Demonstration Guide & Tutorial

5

2 .  T h e  T e n  M i n u t e  D e m o

Working Model’s graphical users interface allows users to model 
and analyze systems very rapidly. This 10 minute demo walks 
you through two simple examples - a ball bouncing down a ramp, 
and a 4-bar linkage.

A Ball Bouncing Down a Ramp
Creating simulations in Working Model is similar to drawing in 
any popular CAD package. Using the tools found in the toolbar, 
you first sketch bodies, then connect them together using 
Working Model’s many different constraints. 

When all bodies and constraints are defined, the simulation is run. 
No pre-processing or post-processing is needed. You immediately 
see results.

Step 1 - Open Working Model 

1. Double-click the Working Model icon to start the demo 
program.

Working Model starts up and begins running a demo script 
written in WM Basic,Working Model’s embedded scripting 
language.

2. A dialog box will pop up, offering you several options.

** Change picture.

Figure 2-1
Untitled Working Model 
Window 

You will see the toolbar on the left and the tape controls along the 
bottom of the window. The toolbar contains tools you will use to 
create simulations. The tape controls give you more control for 

Toolbar

Help Ribbon

Tape Controls
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running and viewing simulations. You can use the tape controls to 
step through simulations, play simulations backwards, or move to 
a specific time in a simulation.

Step 2 - Draw a circle 

The toolbar provides a variety of tools for setting up simulations. 
To choose a tool, click on the corresponding icon on the toolbar. 
The Help Ribbon located at the top of the window helps you 
identify the tools as you move the mouse pointer over the tool 
icons.

To draw a circle (see Figure 2-2):

Figure 2-2
Drawing a circle

1. Click the Circle tool.

2. Position the pointer at any starting point in the blank area 
of the screen. 

The pointer changes from an arrow to a crosshair.  This 
means you are ready to create an object.

3. Press and hold down the mouse button (left button on a 
two-button mouse).  Drag the mouse to draw a circle.  
When the circle reaches the size you want, release the 
mouse button.

A line appears inside the circle. During an animated 
sequence, this line indicates the circle’s rotation.

Step 3 - Draw a Ramp

1. Click the polygon tool.

The pointer changes from an arrow to a crosshair. This means 
you are ready to create an object.
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2. Position the pointer to draw the upper left point (point A) of 
the polygon as shown in Figure 2-3.

Figure 2-3
Creating a ramp with the 
polygon tool

3. Click the mouse button (left button on a two-button mouse) 
and release. Move the mouse to the lower right point (point 
B) of the polygon.

Refer to Figure 2-3. A line is drawn as the polygon is being 
created.

4. Click the mouse button again and release. Move the mouse 
to the bottom left point (point C) of the polygon.

Refer to Figure 2-3. A second line is drawn as the polygon is 
being created.

5. Double click (click twice quickly) on the mouse button. 

The polygon is automatically closed by Working Model, 
creating a ramp.

6. Click the anchor tool.

7. Position the anchor over the ramp with the mouse and 
click.

The anchor pins the ramp to the background, preventing 
gravity from dragging it downward.

Step 4 - Run The Simulation

You are now ready to run your simulation.  To run the simulation:

1. Click Run in the toolbar.

Use the 
polygon 
tool to 

draw the 
ramp

Start drawing the polygon  with 
point A.  Click, then move the 
mouse to point B.

A

BC

Click twice quickly ("double click") 
at point C.  Working Model will 
automatically close the polygon by 
creating a line between C and A.

Place an anchor on the 
ramp to prevent it from 
falling due to gravity.
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Watch your first simulation run. Because normal earth gravity 
is on by default in a new document, the circle drops and 
bounces down the ramp, with Working Model automatically 
handling all contacts and collisions. Note that Working Model 
also handles friction -- the ball spins as it rolls down the ramp.

2. Click once in an empty area of the workspace to stop the 
simulation.

Step 5 - Display a velocity meter

Working Model allows you to measure many physical properties 
such as velocity, acceleration, and energy by using meters and 
vectors. Meters and vectors provide visual representations of 
quantities you want to measure.   

To display a digital meter that measures the velocity of the 
projectile, follow these steps:

1. Click Reset in the toolbar.

2. Select the circle drawn earlier by clicking on it.

3. Choose Velocity from the Measure menu at the top of the 
screen, and choose All from the Velocity sub menu (see 
Figure 2-4).

A digital velocity meter appears (Figure 2-5).

Figure 2-4
Choosing All from the 
Velocity submenu in the 
Measure menu

4. Click Run in the toolbar.

See Figure 2-5. Tracking has also been turned on (by 
selecting Tracking, Every 8 Frames, under the World menu). 
Notice that Working Model handles contacts, collisions and 
frictions automatically.

Step 6 - Change simulation parameters

Every object in Working Model, even input controls, has a series 
of properties, like mass, material, position, etc.  These properties 
can be viewed and modified from the properties window.  

Let’s change the material of the circle to rubber.



Working Model Demonstration Guide & Tutorial

9

1. Double-click on the circle.

The properties window will appear, allowing you to view the 
circle’s position, angle, velocity, material, mass, friction, 
elasticity, charge, and moment of inertia.  Any of these 
properties can be  edited directly within the properties 
window.

2. Position the pointer over the arrow on the “material” drop-
down menu.

3. Press and hold down the mouse button (left button on a 
two-button mouse).  Drag to the material “rubber” and 
release the mouse button.

You can edit other properties by clicking in the box you wnat 
to change and typing in a new value.

4. Click Run in the toolbar.

5. Modify other parameters and re-run.

Double-click again on the ball to open its properties window 
and change its mass, elasticity, and friction coefficient. Re-run 
the simulation. Similarly, change the properties of the ramp. 
Add other objects above the ramp and simulate multi-body 
collisions.

Figure 2-5
Running the simulation 
with tracking and a 
meter

Modeling a Four Bar Linkage
Creating mechanisms with Working Model is a snap. In this 
example, you will create a parametrically-defined four-bar 
linkage using the Smart Editor. 

Step 1 - Create the bars

To construct a linkage consisting of three bars:
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1. Close all open documents prior to starting this demo.

2. Create a new Working Model document by selecting New 
from the File menu. 

3. Double click the rectangle tool on the toolbar. 

The tool will turn black, indicating that it can be used multiple 
times.

4. Sketch a rectangle similar to the one in Figure 2-6.

Figure 2-6
A single rectangle

       

5. Sketch two vertical rectangles below the horizontal 
rectangle.

None of the rectangles should overlap.  **Fix the picture 
bewlow.**

Figure 2-7
The beginnings of a 
four-bar linkage

Step 2 - Placing points on the bars

Here you will learn to use the Object Snap tool to place points 
precisely.  The Object Snap tool highlights commonly-used 
positions, like the center of a side, with an “X”.  If you place a 

Bars overlap here.
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point using Object Snap, the point’s position will be marked by 
parametric equations.  These equations insure that the point 
maintains its relative location even after re-sizing or other 
adjustments.

1. Double click on the Point tool.  **Change the icon at left.**

The tool will turn black, indicating that it can be used multiple 
times.

2. Move the cursor over one of the bars.

You will notice that an “X” appears around the pointer when 
it is centered on a side, over a corner, or over the center of a 
rectangle.  This feature is called “Object Snap” and 
highlights the commonly-used parts of a body.

3. Place the cursor over the center of the top side of one of 
the vertical bars.  When you see an “X” around the pointer, 
click the mouse button.  ** Change picture below.

The beginnings of a 
four-bar linkage

4. Place points, as you did in step 3, like shown in figure ???.  
Make sure you see the “X” when you click the mouse.

5. Selet the Pointer tool.

6. Double-click on one of the points to bring up the properties 
window.

You will notice that the point is defined locally by 0.0 in one 
direction -- so the point stays in the center of that side -- and 
by an equation for the other direction -- half the length or 
width of the body -- so the point always stays at the very end 
of the body.  You may have to re-size the properties window to 
see the full equation.

Click here to create pin joints
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Step 3 - Connecting the points to form pin joints

You will now join the points to create pin joints.  A pin joint acts 
as a hinge between two mass objects.  The Smart Editor will 
prevent joints from breaking during a drag operation.

1. With the pointer tool selected, click and drag on the 
background to make a selection box that surrounds the 
two left points.  Release the mouse button, and the two 
points should now be highlighted (darkened).

This method of selecting objects is called “box select.”  Any 
object that rests completely within the box when the mouse is 
released will be highlighted.

2. Now the Join button in the toolbar will be highlighted.  
Click it.

The two points come together to form a pin joint.  The bars 
may not be straight anymore, but we’ll fix that in a minute.

3. Perform steps 1 and 2 for the two right points.

4. Select the Pin Joint tool (show icon) and place a pin joint, 
again using snap points, at point B as indicated in 
Figure 2-8.

This pin joint will join the rectangle to the background.

Figure 2-8
Adding a motor to the 
linkage.

        

Step 4 - Adding a Motor to the Linkage

We will now attach a motor to one of the bars to drive the linkage.

1. Click the motor tool on the toolbox.

The motor tool will become shaded, indicating that it has been 
selected. The cursor should now look like a small motor.

A

B

C

D
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2. Place the cursor over the bottom of rectangle D (see 
Figure 2-8). Click the mouse.

A motor will appear on the 4-bar linkage as shown in 
Figure 2-8. Similar to a pin joint, a motor has two attachment 
points. A motor will automatically connect the top two mass 
objects. If only one mass object lies beneath the motor, it will 
join the mass object to the background. A motor will then 
apply a torque between the two mass objects it is pinned to.

3. Click Run on the toolbar.

The 4-bar linkage will begin slowly cranking through its 
range of motion.

4. Click Reset in the toolbar.

The simulation will stop and reset to frame 0.

5. Double-click on the motor to open the properties box.

You can also select the motor and choose Properties from the 
Window menu to open the properties box.

6. Increase the velocity of the motor to 300 degrees/second 
by typing this value in the properties box as shown in 
Figure 2-9

Users can define a motor to apply a certain torque, to move to 
a given rotational position, or to turn at a given velocity or 
acceleration.  Rotation, velocity, and acceleration motors 
have built-in control systems that automatically calculate the 
torque needed.  In this demo, we will stick with the velocity 
motor.

Figure 2-9
Properties window for a 
motor

7. Click Run on the toolbar.

The 4-bar linkage will once again begin cranking, this time at 
a much higher velocity.

Edit this field
to read 300.0
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Step 5 - Re-sizing the bars

You will now use the Edit Toolbar on the bottom of the screen to 
adjust the size and angle of the bars.  This section highlights 
Working Model’s parametric features.  Notice that when you re-
size a bar all points stay in their proper positions and all joints stay 
intact.  Because you located the points using Object Snap, they are 
positioned with equations and automatically adjust during design 
changes.

1. If not already selected, click the Pointer tool.

2. Click once on the left-hand bar to select it.

Four black boxes will appear around the bar indicating that it 
is selected.  The boxes are called handles and can be dragged 
to re-size an object.

3. Double-click in the “h” box on the Edit Toolbar at the 
bottom of the screen to change the bar’s height.  Type 2.

The bar will re-size on the screen.

4. Double-click in the “w” box on the Edit Toolbar to change 
the bar’s width.  Type .5.

5. Double-click in the “ø” box on the Edit Toolbar to change 
the bar’s angle.  Type 0.

The bars probably shifted when you joined them.  Setting the 
angle to 0 straightens them back out.

6. Change the height, width, and angle of the horizontal bar to 
1, .5, and 0, resepctively.

7. Change the height, width, and angle of the right-hand 
rectangle to .5, 2, and 0, respectively.

Notice that during this re-sizing the pin joints all stay centered 
on the rectangles.  Parametric equations keep the points in 
their proper relative positions.  

Step 6 - Using the SmartEditor

The SmartEditor allows you to drag a mechanism through its 
range of motion while keeping all joints and connections intact.  
You can check clearances or set new starting points for the 
running of your simulation.

1. Click on the small bar and hold the mouse button down.
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2. Now, still holding the mouse button down, drag the 
linkage.

All three rectangles will follow the motion of the mouse, 
because the pin joints connect them. The Smart Editor does 
not allow joints to separate.

3. Let go of the mouse button and click Run.

Then drag your design to a different spot and click run.  You 
can use the SmartEditor to check the effect of different starting 
positions on your design.

Step 7 - Measuring a Point’s Position

1. Click Reset in the toolbar.

The simulation will stop and reset to frame 0.

2. Select the point tool from the toolbar.

The point tool is located immediately to the left of the pin joint 
tool used earlier.

3. Place the cursor over the horizontal bar of the 4-bar linkage 
and press the mouse button.

A point is attached to the bar. This is a single point, and does 
not attach the bar to the background.

4. If the point is not already selected (darkened), select it by 
clicking on it.

5. Create a meter to measure the position of this point by 
choosing Position from under the Measure menu (see 
Figure 2-10).

A new meter will appear. Position meters default to display 
digital (numerical) information. You can change a digital 
meter to a graph by clicking once on the triangle in the meter’s 
upper left hand corner on Windows machines, or select the 
graph display from a pull down menu that appears when you 
click on the upper left hand corner of the meter in the 
Macintosh version.

Figure 2-10
Creating a meter to 
measure a pins position

6. Click Run on the toolbar.
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Your simulation will immediately begin running and 
measurement information will appear in the meter as shown 
in Figure 2-11. Meter data can be exported to an ascii file or 
copied onto the clipboard and pasted into a spreadsheet 
program for further analysis. In this case the spreadsheet 
would receive four columns of information: Time, X, Y, and 
Rotation. One row would appear for each integration time 
step calculated. 

Figure 2-11
Running the simulation 
with a motor and a meter

 

7. Modify your simulation and re-run.

Working Model’s seamless integration between the editing of 
a model and the running of the dynamics engine allows you to 
quickly investigate many different simulation configurations. 
As an example, modify the mass of the horizontal beam using 
the properties box, and re-run the simulation. You can also 
modify pin joint locations, re-size bodies, measure velocities 
and forces, or even investigate how this 4-bar linkage would 
run in zero gravity by turning gravity off under the World 
menu!

Applying What You Have Learned

You have now finished the 10 minute demo. This demo has 
shown you how to create and run simple simulations in Working 
Model.  We encourage you to experiment with the simulations 
you have already created, or create your own mechanism from 
scratch.  As you will find, Working Model has an incredible array 
of features that will allow you to model and analyze most complex 
mechanical devices.

The motor is
placed at this link.

Click here to select different meter types.

The meter measures the
position of this point.
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The following tutorials continue to explore the features in 
Working Model.  For more information on the toolbar or Working 
Model’s built in function language, please refer to the appendices 
at the end of this demo guide.
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3 .  T u t o r i a l :  D r i v e n  O s c i l l a t i o n

This tutorial introduces you to several Working Model features: 

• Slot Joints

• Springs

• Motors

• Custom graphs

• Slider controls

The problem solved with this tutorial is defined as follows:

Determine the rate (ω) in radians per second that the crankshaft 
must rotate so that resonance occurs. The crankshaft's radius R is 
0.5 meters and the slider pin's position is a distance r = 0.2 meters 
from the crankshaft's center. The spring constant k is 50 N/m and 
the 0.6 meter square block's mass m is 1 kg. All other masses are 
negligible. Assume that there is no friction. 

Introduction
As the frequency of the crankshaft approaches the natural 
frequency of the spring/mass combination, the amplitude 
approaches infinity. This condition is known as resonance.  As we 
will demonstrate in this simulation, resonance can lead to 
catastrophic failure of structures and mechanisms.

You will use a motor and a circular mass object to model the 
driver crankshaft.  The motor's speed will be controlled by an 
input slider.  The connecting rod will be modeled as a rectangular 
mass object attached to a slot on the background. 
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Setting Up the Workspace
For this exercise four changes in the workspace are necessary.  
For clarity, the x-y axes will be displayed.  The number of digits 
displayed after the decimal point will be changed to 1, from the 
default 3, to match the significant figures of the problem.  Third, 
gravity will be turned off.  Lastly, the automatic equation feature 
of Object Snap will be turned off.

1. Choose Workspace from the View menu and select X,Y 
Axis from the Workspace submenu.

The x-y axis will appear on the workspace.

2. Choose Numbers and Units from the View menu.

3. Switch the unit system to SI (radians)

4. Enter 1 into the Digits field.

The number of digits displayed to the right of the decimal will 
be set to 1.

5. Click OK.

6. Choose Gravity from the World menu.

7. Click the None box.

Gravity will be turned off.  This step eliminates both the need 
for the “floor” and the force calculations between the floor 
and the block.  

8. Click OK.

9. Choose Preferences from the Edit menu.

A dialog box with a series of check boxes will appear.

10. Click the check box labeled “Automatic point equations on 
Object Snap”.

Initially the box should be checked.  After you click, the check 
should disappear, indicating that the equations feature has 
been turned off.

Creating the Components
This exercise has three mass objects, a 0.5 meter radius circle, a 2 
meter long connecting rod and a 0.6 meter square block with a 
mass of 1 kilogram.  The objects will be created, sized and 



3. Tutorial:  Driven Oscil lat ion

20

initialized in the following steps.  For clarity we will place the 
components along the x-axis.  The block will be placed at the 
origin.  All other positions will be referenced from the block.

Creating the Block

The block will be modeled by a square mass object.  The square 
will be drawn with the Square tool.  Its size, 0.6 meters, will be set 
with the Geometry utility window.  It will be positioned at the 
origin using the Properties utility window.

To draw the block:

1. Choose the Square tool.  

Place the pointer over the Rectangle tool on the toolbar, click 
and hold until the Rectangle tool pop-up menu appears (see 
Figure 3-1 below). Choose the Square tool.

Figure 3-1
The Square pop-up 
menu

2. Drag out a square.

Position the pointer in the background, press and hold the 
mouse button down, move the mouse up and to the right.  Now 
release the mouse button.

To size the block:

1. Select the square if it is not already selected.

2. Click in the Height or Width field in the Edit Toolbar and 
enter 0.6.  Press Return.

Either field will change both the height and the width of the 
object so that it remains square.

To set the block's mass:

1. Select the square.

2. Choose Properties form the Window menu.

3. Click in the Mass field and enter 1.0.

To position the block:

1. Select the square.

Click and hold
until the pop-up
menu appears
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2. Click in the X field on the Edit Toolbar and enter 0.  

3. Click in the Y field and enter 0.

The square is now at the origin. Use the scroll bars to position 
the block as shown in Figure 3-2.

Figure 3-2
The block at the origin

   

Creating the Driver Crankshaft

The crankshaft will be modeled by a circle.  The circle will be 
drawn with the circle tool.  Its radius, 0.5 meters, will be set using 
the Geometry utility window.  Its position, 6.5 meters to left of the 
block, will be set with the Properties utility window.  To draw the 
crankshaft:

1. Click the Circle tool on the toolbar.

2. Drag out a circle.

To size the crankshaft:

1. Select the circle.   

2. Click in the Radius field in the Edit Toolbar and enter 0.5.

It is important to keep everything aligned vertically.  To position 
the crankshaft:

1. Select the circle.

2. Enter -6.5 and 0 into the x and y fields, respectively, on the 
Edit Toolbar.

Your screen should resemble Figure 3-3 below.

x-axis

Block

y-axis
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Figure 3-3
The crankshaft in 
position

   

Creating the Connecting Rod

The connecting rod will be modeled as a rectangle.  It will be 
drawn using the rectangle tool.  Though its height could be any 
value, it will be set at 0.35 meters to resemble the connecting rod 
in the problem.  To set the rectangle size, the Geometry utility 
window will be used.  Its position, 2.5 meters to the left of the 
block, will be set using the Properties utility window.  

To draw the connecting rod:

1. Choose the Rectangle tool from the Rectangle pop-up 
menu.

2. Drag out a thin rectangle.

To size the rectangle:

3. Enter 0.35 and 2 into the height and width fields, 
respectively. 

To position the rectangle:

1. Select the rectangle.

2. Enter -4 and 0 in the x and y fields, respectively.

Creating the Elements for Joining
In this exercise, many points will be created.  Most points will be 
created automatically when the tools for the spring, slot, and 
motor are used.  Only the point and slot from the crankshaft-to-
connecting rod joint will be created with element tools.
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Creating a Point on the Crankshaft

The crankshaft needs to be attached to the connecting rod.  The 
connection will be made using a point on the crankshaft and 
joining it to a slot on the connecting rod.  The point on the 
crankshaft is positioned 0.2 meters from the crankshaft's center.  

To draw the point on the crankshaft:

1. Click the Point tool on the toolbar.

2. Click on the crankshaft.

To position the point:

1. Select the point if is not already selected.

2. Click in the X field and enter the value 0.2.  Press the Return 
key.

3. Click in the Y field and enter the value 0.

Creating a Slot on the Connecting Rod

In the exercise the connecting rod has a slot on which the 
crankshaft slides.  To model this, a slot will be placed on the 
connecting rod.  To create the slot:

1. Choose the Vertical Slot tool.

Choose the slot by placing the pointer over the Horizontal slot 
tool on the toolbar, clicking and holding until the Slot tool 
pop-up menu appears (see Figure 3-4 below). Choose the 
Vertical Slot tool to the right.

Figure 3-4
The Slot pop-up menu

2. Click on the Snap Point, indicated by the “X”, on the center 
of the left side of the connecting rod. 

A slot will appear.

Your screen should look like Figure 3-5 below.

Click and hold until
the Slot pop-up menu
appears.
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Figure 3-5
The connecting rod with 
the slot on it

    

Creating the Constraints
Exercise 2 requires four constraints: a keyed slot, a variable speed 
motor, a 50 N/m spring, and a slot on the connecting rod.  The 
following steps will describe how to create these constraints with 
Working Model.

Creating the Keyed Slot 

The connecting rod slides in a sleeve.  The sleeve prevents the 
connecting rod from moving vertically or rotating.  To model the 
sleeve, a keyed slot joint will be used.  The Keyed Slot tool 
attaches a square point to the top mass object, and a slot to the 
object beneath the point (in this case it is the background), and 
then automatically joins them.  The position of the keyed slot is 
not critical.  It can be placed anywhere on the connecting rod.  

To create and position the keyed slot:

1. Choose the Horizontal Keyed Slot tool from the Slot pop-up 
menu on the toolbar (see Figure 3-6 below).

Place the mouse pointer over the slot tool.  Click and hold the 
mouse button down until the pop-up menu appears.  Choose 
the horizontal slot.

Figure 3-6
The Slot pop-up menu

2. Click on the connecting rod.

Crankshaft

Connecting rod

Block

PointSlot

Slot

Click and hold until
the Slot pop-up menu
appears.
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A slot will appear on the background. It will be joined to a 
point on the connecting rod (see Figure 3-7 below).

Figure 3-7
A keyed slot joint 
attaches the 
connecting rod to 
the background

   

Creating a Spring

To create the spring, the Spring tool will be used. The spring 
constant is preset at 50 N/m. To draw the spring:

1. Click the Spring tool on the toolbar.  

2. Click on the center of the right side of the connecting rod 
rectangle and drag to the center of the block. Release the 
mouse button on the block.

Use Object Snap to position the spring endpoints precisely.

Your workspace should resemble Figure 3-8 below.

Figure 3-8
The spring attached 
is to the block and 
connecting rod

   

Keyed slot joint
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Creating the Drive Motor
The crankshaft is driven by a motor.  Its position will be set using 
the Properties utility window

To draw the Motor:

1. Click the Motor tool on the toolbar.

2. Click at the center of the circle when you see the “X”.

When a motor is created, two points are also created.  One 
point is attached to the circle (the Point) and one is attached 
to the background (the Base Point).

Creating a Slider Input Device
This tutorial asks for the rotational speed of the motor when 
resonance occurs. Different speed values could be entered via the 
Properties utility window, but a much more efficient way is to 
create an input device called a slider. 

To create a slider:

1. Select the crankshaft motor by box selecting it.

2. Choose New Control from the Define menu, and Rotational 
Velocity from the New Control submenu.

A slider similar to the one in Figure 3-9 below will appear on 
the screen.

Figure 3-9
A slider is created
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Setting the Range of a Slider

The default range of a slider is not a proper one for the problem.  
To modify the slider range:

1. Select the slider by clicking on its name.

2. Choose Properties from the Window menu.

3. Enter 10 in the Max field of the slider's Properties window.

Joining the Connecting Rod to the 
Crankshaft
There are only two points in this exercise which need to be joined, 
the point on the crankshaft and the slot on the connecting rod.  To 
create the joint between the connecting rod and the crankshaft:

1. Select both the point on the crankshaft and the slot on the 
connecting rod.

The Join button in the toolbar will become highlighted.

Use box select to select two objects.  Alternatively, you can 
shift-select multiple objects.  To shift select, select one object, 
and hold down the shift key to select another.  Hold the shift 
key down to select more objects, if so desired.

2. Click the Join button on the toolbar.

Setting the Spring's Rest Length

When the connecting rod and crankshaft were joined, the 
connecting rod moved a substantial distance to the left.  This 
movement stretched the spring, pre-loading it.  To remove the 
pre-load, the spring's rest length will be reset to the larger current 
length.  

To reset the springs rest length:

1. Select the spring.

2. Choose Properties from the Window menu.

3. Click on the “(current)” value.

The value in the “length” field will automatically change to 
the current length.  The spring's rest length will now be set to 
the current length.
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Preventing a collision

The connecting rod and block will collide when resonance is 
achieved.  The collision will dampen the motion of the block.  To 
make the results of the simulation more interesting we will 
prevent the connecting rod-block collision.  

To prevent a collision:

1. Select the connecting rod and, while holding the Shift key, 
select the block.

2. Choose Do Not Collide from the Object menu.

The model is now complete and can be run.

3. Click the Run button on the toolbar.

4. Move the slider bar up and down to see the effect on the 
rotation of the crankshaft.

5. Click the Reset button.

Measuring Properties from the 
Simulation
It is interesting to watch the graphical motion of the driver and the 
driven objects as they interact in this simulation.  To do so, a 
graph displaying two properties must be created.

Creating the Graph

The following steps describe how to create a graph of the block's 
position vs. time.  The graph will be moved to the bottom of the 
screen.  It will be enlarged so it reaches across the screen.  To 
display the graph:

1. Select the block.

2. Choose Position from the Measure menu, and X Graph 
from the Position submenu.

This meter will graph the x position of the block (driven mass) 
with respect to time.

To position the graph:

1. Select the graph.

2. Click on the graph and drag it to the lower left corner of the 
screen.
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To size the graph:

1. Select the graph.

Four squares (called handles) will appear at the corners of the 
graph indicating the meter is selected.

2. Click on the lower right handle and drag to the right side of 
the screen.  

The graph will stretch to a larger size (see Figure 3-10). 

Figure 3-10
An x-y graph is added

   

Adding a Parameter to the Graph

The second object of interest to graph is the connecting rod 
(driver).  To add the parameter to the graph:

1. Select the graph.

2. Choose Properties from the Window menu.

3. Click in y2's Label field and type “driver” (see Figure 3-11 
below).

This titles the new parameter.  The text “driver” will appear 
in the y-axis of the graph.

Figure 3-11
Meter's Properties utility 
window
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4. Press the Return key.

This enables the meter's y2 Equation field, allowing for 
editing of that field.

Note: some text must be entered into the Label field or the 
Equation field will remain disabled.

5. Click in the y2's Equation field and enter the following 
formula:

mass[object id].p.x

The object id number for the connecting rod can be 
determined by placing the cursor over the connecting rod and 
reading the ribbon help at the top of the workspace.

This will produce a graph of the values of the connecting rod's 
x-position.

Setting the Range of a Graph

Changing the x and y range of a graph can improve the quality of 
the graphical output.  To set the range:

1. Select the graph.

2. Choose Properties from the Window menu.

3. Click on y1's Auto checkbox to turn off auto ranging.

Enter the title Enter the equation

Enter the range values
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4. Enter various values into the Max and Min fields of y1 and 
y2 variables (see Figure 3-11 above). The following values 
work well:

Experiment with different values and notice the changes in the 
graph. Be sure to turn off automatic range after you enter your 
variables or Working Model will modify the values.

Checking the Answers
Congratulations, the tutorial is now completed. Run the 
simulation, varying the motor speed until resonance is achieved.

The equation for the amplitude of driven harmonic motion is:

 where:

• A is the block's displacement amplitude

• F is the driving force

• m is the block’s mass 

• ω is the frequency of the driving force

• ωo is the natural frequency of a spring-mass combination  

As the frequency of the driver (ω) approaches the natural 
frequency of the spring/mass combination (ωo), the amplitude 

approaches infinity. This condition (ω = ωo) is known as 
resonance. For this exercise resonance will be achieved when the 

crankshaft's rotational velocity reaches ωo =  , 7.1 rad/s. 

Click in the slider's field and enter the value 7.1. 

Now run the simulation. 

Min Max

y1 -5.0 6.0

y2 -7.5 -4.0

A =
F

m2 (ω 2 − ωo
2 )

k

m

k

m
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4 .  T u t o r i a l :  I m p o r t i n g  C A D  F i l e s

This tutorial will allow you to analyze an existing robot welder 
design by importing a CAD file into Working Model.  The CAD 
file will be used for key geometries as well as accurate location of 
pin joints.

Tutorial 2 Concepts:

• Importing DXF files.

• Creating bodies in Working Model from lines that have been 
imported from a DXF file.

• Using the Join command to accurately build models.

• Creating and controlling actuators with slider input devices.

Introduction
Working Model’s DXF import feature allows users to perform 
dynamic analysis on models drawn in CAD programs. With this 
feature, complex geometries and accurate pin placements from 
existing CAD files can easily be imported into Working Model. 
In addition, the ability to import DXF drawings allows users to 
take advantage of the sophisticated drawing tools found in high-
end CAD packages

This example uses an existing DXF file exported from a popular 
CAD package. Virtually any CAD program that supports DXF 
files can be used, including AutoCAD® , Vellum® , CADKEY® , 
and MicroStation® . The tutorial walks the user through the 
import process and shows how bodies and joints are created. 
Slider controlled actuators are then added, and the robot-welder is 
put in motion.

It is assumed that the user has already completed tutorial 1.

Preparing CAD Files for Export into 
Working Model
CAD drawings typically contain large amounts of detail that are 
not needed or used in a dynamics analysis. For example, rivets 
and screw threads may be included in a CAD drawing, but are not 
relevant to dynamic analysis and will slow down the simulation.
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Before importing a CAD drawing into Working Model, users 
typically pre-edit to remove all but key body geometries and 
points where pin joints will be attached.  In addition, large 
assemblies are split away from one another so that line segments 
can be simultaneously selected and converted into bodies once in 
Working Model.  Bodies can also be created directly in the CAD 
package by creating closed polyline constructs before importing.

Figure 4-1
Robot Welder Drawing

   

The CAD drawing that will be used for this tutorial is shown in 
Figure 4-1. The drawing has been pre-edited to remove all but the 
key geometries and points. It is made up of arcs (including arc 
fillets), lines, and points. For this tutorial, we will not create 
closed poly-line constructs before importing.

Importing Into Working Model
The DXF file used in this tutorial is included on your 
demonstration disk, and is titled ROBOT.DXF.

To import the DXF file:

1. Open a new document.

Make sure all other documents have been closed.

2. Select English (pounds) from the Numbers and Units 
dialog (selected from the View menu)

Before importing a file, it is very important to change to the 
unit system the CAD file was created in. While DXF files 
contain accurate numerical information on geometries, they 
carry no unit system information. If you forget to change to the 
correct unit system before importing, you may suddenly find 
yourself working with a 5 meter robot arm (vs. 5 feet)! 
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3. Select Import from the File menu.

The import dialog box will pop-up as shown in Figure 4-2 
(Macintosh version - Windows will be slightly different). 

Figure 4-2
The Import Dialog box

   

4. Locate and select the file named “ROBOT.DXF” from the 
dialog box, then click on the Open button.

The DXF file import will begin.

Working Model provides dialog boxes to inform the user as to the 
progress of the import. All DXF objects are first read from the 
file. Next, these objects are converted into Working Model 
entities. Finally, these new entities are merged into the existing 
Working Model document. Large DXF files may take as long as 
1-2 minutes to read in and convert, depending on the speed of 
your machine.

Current unit settings (as given in the Numbers & Units dialog 
box) are applied for DXF files. For example, if an original CAD 
drawing had a 20-inch long object, and if you imported this DXF 
file under SI unit system (where length is measured in meters), 
then the object would become 20-meter long.

5. Notice how objects have been converted.

Working Model converts arcs and spline based DXF objects into 
a series of very small line segments. Although the objects you see 
in Figure 4-3 appear to have smooth, rounded edges and curves, 
they are actually made up of many individual lines segments.   
Points are attached to background (since DXF file does not have 
any information on which points belong to which objects) and 
show the accurate position of where pin joints will be located.



Working Model Demonstration Guide & Tutorial

35

Figure 4-3
DXF File Imported to 
Working Model

   

Converting Imported Lines Into Bodies
This DXF file contained many small line segments and no closed 
poly-line constructs.  Therefore, all groups of lines must now be 
converted into bodies which Working Model can use in a 
simulation.

1. Choose the arrow tool from the tool palette.

2. Box select the upper left hand grouping of lines (see 
Figure 4-3).

To box select, first click to create the first corner of the box, 
keeping the mouse button down.  With the mouse button down, 
drag to create the box.  Release when all line segments are 
enclosed in the box.  The line segments will become 
highlighted as they are selected.

3. Convert these lines into a polygon (which is a Working 
Model body) by selecting Convert Objects/Convert to 
Polygon from the Object menu.

See Figure 4-4.

Figure 4-4
Object Conversion 
Submenu
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4. Similarly, convert the remaining two groups of lines into 
polygons.

Attaching Points to Bodies
Pin joints can be accurately created in Working Model by first 
specifying the exact pin locations with points in a CAD program.  
When points are imported into Working Model, they are initially 
attached to the background.  They must then be attached to the 
appropriate body.

1. Box-select the center body.

The box will enclose  both the pins beneath the body, selecting 
the body and both pins.  Multiple pins can be attached to a 
mass simultaneously. 

2. Select Attach To Body from the Object menu.

Select Attach to Body as shown in Figure 4-5. Attach To Body 
will attach all selected points to the selected body object 
without moving any of them.

Figure 4-5
Attach to Mass menu 
item

   

3. Similarly, attach the remaining pins to each body.
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Pinning Bodies Together with the Smart 
Editor
Designs can be accurately built by using Working Model’s Smart 
Editor.  In this tutorial, the Join feature of the Smart Editor will be 
used to create pin joints from the pins we just attached to each 
mass.  The Smart Editor will automatically reposition a body 
during a Join command in order to make the pin joint.  To prevent 
a body from moving or rotating during Join command, the anchor 
tool is used.

1. Select the Anchor tool from the palette.

2. Place the Anchor on the base of the robot welder.

The base is the lower body. The anchor can be placed 
anywhere on the body. See Figure 4-6 as an example.

3. Select the pin on the base by clicking the mouse on it.  
Holding the shift key down, select the left-most pin on the 
center arm of the robot welder.

See Figure 4-6. Holding the shift key down during selections 
allows you to select multiple objects. Note that the Join palette 
button is active.

Figure 4-6
Anchoring the base

   

4. Create a pin joint with these two points by clicking on the 
Join command in the palette.

The center arm body will move in order to create the pin joint 
because the base has been anchored down.  If neither had 
been anchored, the Smart Editor would move whatever is most 
convenient.

Base

Center Arm

Right Arm
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5. Similarly, create a pin joint between the right most pin on 
the center arm body and the right arm body using the two 
remaining pins.

Both arms now move during the Join command because 
neither is anchored down.  The base will not move or rotate.

Repositioning Bodies After Joining
Bodies have a rotational orientation that is defaulted to 0 (in the 
current unit system) when they are created.  In order to easily 
attach actuators, we first must reorient the center and right arm to 
their default rotation.

1. Select the center arm body by clicking on it.

The center arm body will become highlighted.

2. Change the rotational orientation of the center arm body to 
0 in the ø field on the Edit Toolbar.

See Figure 4-7. Press tab after typing in a zero. The center 
arm body will move to the orientation it had when it was first 
created.

Figure 4-7
Properties Window

   

3. Similarly, change the rotational orientation of the right arm 
body.

Smart Editor may decide to slightly rotate the center arm as 
well. It’s okay. If this adjustment is annoying, you can 
temporarily anchor down the center arm before you set the 
right arm rotation to zero, and delete the anchor later.
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Attach the Actuators to the Robot Welder
We will use two “length” actuators to control our robot welder. A 
“length” actuator takes a length as input, and provides the needed 
force at its endpoints to achieve this length. These actuators can 
be accurately placed with the Smart Editor if desired. We will 
position the actuators only roughly in this tutorial.

1. Select the actuator tool from the palette.

First, you will create the left most actuator as shown in Figure 4-8.

2. Click on the base.  Hold the mouse button down and draw 
the actuator until it reaches the right arm.  Release the 
button when it is in the correct position.

An endpoint is automatically attached to a body when the 
arrow is positioned over it during clicking of the mouse 
button.

Figure 4-8
Robot arm with 
Actuators

   

3. Similarly, create the second actuator as shown in Figure 
4-8.

Create Input Sliders to Control Each 
Actuator’s Length
We will now create input sliders to control each actuator’s length 
(these actuators can also be controlled with a formula, or even 
through a link to an external program like Excel or MATLAB).

To create the sliders:

1. Select an actuator by clicking on it.

The actuator will become highlighted.
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2. Choose New Control/Length from the Define menu.

See Figure 4-9.

A slider will appear on the screen.

Figure 4-9
New Control Submenu

   

3. Similarly, create a slider for the second actuator.

Change the Input Slider Ranges
The input slider ranges are defaulted to a range that is too narrow 
for this simulation. We will now change the range of each input 
slider. To do so, we will select both sliders and change their 
ranges in one shot.

1. Select the two sliders by shift-select or box-select.

If you choose to shift-select, click on the upper portion of each 
slider in order to select it.  Four black squares (called 
selection handles) will appear when the slider is selected.

2. Open the Properties window from the Window menu.

The Properties window bears the name “mixed selection”, 
indicating that more than one object are selected.  The 
changes you make in the window will affect all the objects 
currently selected.

3. Enter -3 and 3 as the appropriate minimum and maximum 
range values.  Use the Tab key to enter the value.

See Figure 4-10. These values will allow you to fully exercise 
your robot welder through a wide range of motion.

Figure 4-10
Properties Window for 
Actuators
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Running the Simulation
The simulation is now ready to run.  In order to optimize the 
simulation speed:

1. Choose Accuracy in the World menu.

The Accuracy dialog box appears (see Figure 4-11).

Figure 4-11
Accuracy Dialog Box

   

2. Select Fast mode by clicking on the button in the Accuracy 
dialog box.

The fast mode will allow Working Model to present smoother 
and faster animation than the Accurate mode, although the 
latter provides higher accuracy. 

1. Click on the Run button in the palette.

2. Move each slider through its range to see how it affects the 
robot welder’s motion.

See Figure 4-12. Note that we have changed the color of the 
robot welder using the Appearance dialog box available from 
under the Windows menu. In addition, we have turned on 
tracking from the World menu in order to take a “snapshot” 
at predetermined times during the simulation.

Set the range as shown.

Click on this button to choose the Fast mode.
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Figure 4-12
Running a simulation 
with the robot arm

   

3. Using Meters, Measure the forces exerted by the actuators 
to reach the length you specify. Change the position of the 
actuator endpoints to see how the change affects the 
forces.

The force exerted by an actuator can be measured by first 
clicking on the actuator and then selecting the desired 
property in the Measure menu. Pin placements can be 
repositioned directly with the mouse, or by typing in accurate 
values in the endpoint’s Properties dialog box.

Notes on 
Actuators

The length of actuators in the Properties window (or in the slider 
controls as shown in this tutorial) is specified as the offset from 
their initial length (i.e., the length when they were first created). 
Therefore, setting the slider to -3.0 does not make the actuator   
3.0 meters long with switched endpoints. Instead, the actuator will 
be 3.0 meters shorter than when it was first created.

The physical length of an actuator cannot be negative.  For 
example, if you drew an actuator of length 2.0 meters and set the 
slider bar for its length to be -3.0 meters, then the physical length 
of the actuator will end up being 2.0 - 3.0 = -1.0 meters.  Such 
setting will cause the simulation to be spurious and inaccurate.

Notes on 
Inconsistent 
Constraints

You may notice that certain actuator lengths lead to impossible 
configuration of the robot arm. For example, in Figure 4-8, 
suppose the bottom actuator (connecting the base and the mid 
arm) retains the length as shown, while the top actuator is 
specified to be twice as long. Then the positions of the pin joints 
and actuator endpoints would be inconsistent.
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In such cases, Working Model simulation will become spurious. 
You can have Working Model detect inconsistent constraints 
automatically by turning on the Inconsistent Constraint warning. 
To activate the warning:

1. Choose Accuracy in the World menu.

The Accuracy dialog box appears.

2. Click on the More button (on Windows) or More Choices 
button (on Macintosh).

The Accuracy dialog box expands to show more settings.

3. Under warnings, turn on the Inconsistent Constraints.

A checkmark appears in the box to indicate that the 
inconsistent constraint detection feature is active.

More Analysis
You have now constructed a robot welder from an imported DXF 
format CAD file. The types of analysis you can conduct on this 
model are virtually unlimited. Check forces on pin joints, 
calculate the maximum force that a particular actuator 
configuration can lift, or even develop a controller using a 
program like MATLAB - then watch as you welder responds to this 
controller’s commands.

The Next Step
Congratulations! You have now completed all of this guide’s 
tutorials, and should have a good understanding of how powerful 
Working Model is.

The demonstration version of the software permits you to create 
your own simulations of mechanisms with up to five bodies. We 
encourage you to model several of your own mechanical systems 
to understand how Working Model can help you design more 
accurately and efficiently. If you have any questions during this 
process, a sales representative will be happy to assist you.

We hope you have enjoyed this demonstration copy. Please pass 
it on to a colleague or a friend when you are finished. When you 
are ready to place your order, please call us at the number on the 
back of this guide. We look forward to hearing from you.
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5 .  A p p e n d i x

Toolbar
Every Working Model simulation window has a toolbar on the 
left side. The toolbar (Figure 5-1) provides access to the tools you 
will use to create simulations.

Figure 5-1
The Toolbar and 
Pop-up Palettes

The toolbar contains a series of boxes, each of which displays an 
icon that represents a specific tool. Some of these boxes are pop-
up palettes (to save space and to provide easy access to a set of 
tools). Pop-up palettes are indicated by a small arrow in the lower 
right-hand corner of the box. 

To open a pop-up palette, position the pointer on a box with an 
arrow in the lower right-hand corner, and press the mouse button. 
The pop-up palette appears to one side of the box. Drag the 
pointer to highlight the desired tool and release the mouse button. 
The last selected tool is displayed. You can always click on the 
icon to re-select the tool without opening the pop-up palette.

Text

Run

Reset

ArrowRotate

Zoom In, Out

Rectangle, SquareCircle

Anchor

Point Element

Square Point Element
Slot 

Elements

Join

Split

Rod

Separator, Rope

Pulley, Gear

Motor Actuator

Force, Torque

Damper, Rotational Damper

Spring, Rotational Spring, 
Spring-Damper

Slot Joints

Pin Joint

Rigid Joint

Polygon
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If you click once on a tool, it will be selected for the next 
operation; after that operation the selected tool will revert to the 
Arrow. If you want to use a tool for several successive operations, 
then you should double-click on it. This difference (single vs. 
double-clicking) will be indicated on the tool palette by color: a 
double-clicked item will be dark gray, while a single-clicked item 
will be light gray. To quickly select the Arrow tool, press the 
space bar. To quickly select the Rotate tool, press the “r” key. 

The Working Model toolbar consists of the following tools:

The Run button starts a simulation. When a simulation is in 
progress the Run button will be replaced with a Stop button. A 
click on the Stop button will stop the simulation.

The Reset button is used to bring a simulation back to its initial 
conditions (the first frame).

The Arrow tool is used to select an object or a group of objects, 
or to drag a selected group of objects on the screen. Pressing the 
space bar will automatically select the Arrow tool.

The Rotate tool is used to rotate an object or a selected group of 
objects. Objects can be rotated about their center of mass, as well 
as about pin joints and measurement points. You will see a line 
snap to the points about which objects can be rotated.   You can 
use a keyboard shortcut by pressing the “r” key to select the 
Rotate tool.

The Text tool is used to enter text directly onto the simulation 
workspace.

The Zoom pop-up palette has two selections: Zoom In and Zoom 
Out. 

The Zoom In tool increases the magnification of the 
workspace by a factor of two (2x). The new view is centered 
on the area around the pointer. Holding down the shift key 
will toggle this tool to the Zoom Out tool. 

The Zoom Out tool decreases the magnification of the 
workspace by a factor of two (1/2x). Holding down the shift 
key will toggle this tool to the Zoom in tool. 

The Circle tool is used to create circular mass objects. 

The Rectangle/Square pop-up palette has two selections: Square 
and Rectangle.

The Square tool is used to create square mass objects.
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The Rectangle tool is used to create rectangular mass 
objects.

The Anchor tool locks the motion of mass objects. Anchored 
masses will not move unless an equation is entered to control their 
position. As a shortcut, you can press “a” to select the tool.

The Polygon tool is used to create irregularly shaped mass 
objects. Define each point with a single click. Double-click to 
signal the last point, or press the space bar after you single-clicked 
the last point. The polygon will automatically close, connecting 
the first point with the last point. You can later edit polygons 
graphically (choose Reshape in the Edit menu) or numerically 
(select polygon, and choose Geometry in the Window menu).

The Point Element tool is used to create a point element. Points 
can be used for measuring properties at a specific location on a 
mass object. A point can be combined with a slot or another point 
to form a joint (a slot joint or a pin joint). The Join command is 
used to combine Point elements into joints.

The Pin Joint tool is used to create a pin joint. A pin joint 
prevents separation between two mass objects at the location of 
the pin, but allows rotation. All joints can join a single mass object 
to the background.

The Square Point Element tool is used to create a square point 
element. A square point can be combined with a slot or another 
square point to form a joint (a keyed slot or a rigid joint.

The Rigid Joint tool is used to create a rigid joint. A rigid joint 
prevents movement or rotation between two mass objects.

The Slot Element pop-up palette has tools for creating horizontal 
and vertical slot elements.

The Horizontal Slot tool is used to create a horizontal slot 
element. A slot joined to a point forms a slot joint. A slot 
joined to a square point forms a keyed slot joint. (A 
description of keyed- vs. pinned-slot joints is found further 
below.)

The Vertical Slot tool is used to create a vertical slot 
element.

The Curved Slot tool is used to create a curved slot from a 
series of smoothly interpolated (splined) control points. 
Define each control point with a single click, and double-
click the last point.
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The Closed Curve Slot tools is used to create a slot 
consisting of a closed curve. Define each control point of 
the curve with a single click. Double-click to signal the last 
point. The curve will automatically close, connecting the 
first point with the last point.

The Slot Joint pop-up palette has tools for the horizontal, vertical, 
and curved versions of the Slot Joints. The straight slot joints may 
be pinned or keyed.

A pinned slot joint forces a point on one mass object to 
align with a slot on the second mass object or the 
background, while permitting rotation.

A keyed slot joint forces a point on one mass object to align 
with a slot on the second mass object or the background, 
while prohibiting rotation.

The Join button forms a joint from two elements. Select both 
elements—use the shift key to select multiple objects—and then 
click the Join button. The elements need not overlap. Joining two 
point elements will form a pin joint. Joining two square point 
elements will form a rigid joint. Joining a slot element with a point 
forms a pinned slot joint. Joining a slot element with a square 
point forms a keyed slot joint.

The Join button also recombines elements that have been 
separated using the Split button.

The Split button separates a joint into its component elements. 
Select a constraint and then click the Split button. A dashed line 
indicates the separated elements of a constraint. The Join button 
recombines constraint elements that have been separated using 
the Split button.

The Rod tool creates a massless, inflexible link between two mass 
objects. Rods cannot be compressed or extended. Rods can be 
attached between one mass object and the background, or 
between two mass objects. The endpoints of the Rod are its 
attachment points and function as pin joints.

The Spring pop-up palette provides three tools:

Springs resist stretching or compression. Springs can be 
attached between one mass object and the background, or 
between two mass objects (the endpoints of the spring are 
the attachment points and function as pin joints).

Rotational Springs produce a twisting force as they are 
wound up. Rotational springs can also be placed on top of a 
single mass object, in which case they will connect the mass 
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object and the background. A rotational spring that is placed 
on two overlapping mass objects will be connected to both 
mass objects. Rotational springs have a built in pin joint.

Spring-Dampers provide a combination spring and 
damper. Spring-dampers can be attached between a mass 
object and the background or between two mass objects (the 
endpoints of a spring damper are the attachment points and 
function as pin joints).

The Pulley / Gear tool palette has two tools.

A Pulley tool creates a rope threaded through several 
pulleys. Define each pulley with a single click. Double-
click to signal the last pulley. Any pulley within a link can 
be attached to either the background or to a mass object.

Since Working Model approximates pulleys as “thread 
holes” through which a rope is routed, they are massless and 
dimensionless.

A Gear tool connects any two mass objects with a gear 
constraint. Press and hold down the mouse button on one 
object, and drag the mouse pointer to the other to define a 
pair of gears.

By default, Working Model defines gear constraints to be 
external (spur) gears. You can define internal gears (one of 
the gears is inside the other) by choosing the option from 
the Properties window. The gear icon on one of the mass 
object changes to a gear showing internal teeth.

The Force/Torque pop-up palette has two tools:

A Force acts on the mass object to which it is attached. The 
point of application can be positioned anywhere on the 
mass object. The direction of the force can be fixed with 
respect to the background or to the mass object. 

Torques apply a “twisting” force. 

A Motor exerts a twisting force between two masses. Each motor 
has a built in pin joint. A motor can be placed on top of a single 
mass object, in which case it will connect the mass object and the 
background. A motor that is placed on two overlapping mass 
objects will be connected to both mass objects.

The Actuator tool creates an object that exerts a force between its 
endpoints. Actuators can be attached to two mass objects or to one 
mass object and the background. The endpoints of the actuator are 
the attachment points.
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Using Formulas
This section briefly describes the Working Model formula 
language. Working Model allows you to enter formulas in most 
places you would typically enter a number. Formulas enable you 
to build custom forces and constraints and to dynamically control 
the behavior of objects. Formulas are also used to link input 
controls to the simulation, and to control the data displayed by 
meters and output devices. For an example of how a formula can 
be used in Working Model, please refer to the tutorial in Chapter 
3, “Tutorial: Driven Oscillation”.

Formulas in Working Model follow standard rules of 
mathematical syntax, and strongly resemble the equations used in 
spreadsheets and programming languages. Formulas are 
composed of identifiers, fields, operators, and functions. These 
are in turn described below.

Identifiers

Identifiers are used in formulas to identify an object. There are 
five basic types of identifiers. 

body[3] - {rectangles, polygons}

point[2] - {point, square point}

constraint[44] - {e.g. ropes, actuators}

output[12] - {meters}

input[5] - {controls}

The number in the bracket refers to the object ID. Each object in 
Working Model has a unique ID. To find an object’s ID, double 
click the object to display the Properties window for that object.

Fields

Each identifier in the Working Model formula language can have 
fields, which are used to access the values of basic properties such 
as position and velocity. Fields are specified by listing the 
identifier, a period (.), and then the field name. For example, to 
access the moment of inertia of a body object with an ID of 3, you 
would enter the following:

body[3].moment

Sometimes you will use two fields in a row. To obtain the rotation 
of a body object, you enter the following formula:
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body[2].p.r

The body[n] identifier has two-level fields. The first level, 
body[2].p, refers to the configuration (x-y position and 
orientation) of body object 2 and is a 3-component vector. The 
field p has the second level of field r, which represents the angle. 
As a result, body[2].p.r refers to the orientation of the body[2]. 
Shown below is a list of fields that can be used in the Working 
Model demonstration:

Type Field Returned

Vector .x number
.y number
.r number

Body .p vector
.v vector
.a vector
.mass number
.moment number
.charge number
.staticfric number
.kineticfric number
.elasticity number
.cofm point
.width number
.height number
.radius number
.vertex[n].x number
.vertex[n].y number

Point .p vector
.v vector
.a vector
.offset vector
.body body
.force vector

Constraint .length number
.dp vector
.dv vector
.da vector
.p1 point
.p2 point
.force vector

Output .x number
.y1 number
.y2 number
.y3 number
.y4 number

Input (none) number
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Operators

Operators include all of the common algebraic symbols (+, -, >, 
=,<=,>=).

Functions

Functions take from zero to three arguments, and return a number 
or vector value. All functions accept their arguments in the form 

function(arg1, arg2.....)

There are two kinds of functions available. Math functions 
perform standard mathematical operations. Simulation functions 
return information from Working Model simulations.

Math Functions

In the reference list below, the parameter types of the functions 
are shown as:

• a, b, c for numbers

• x, y, z for vectors.

Name and usage Output(return value)

abs(a) absolute value
and(a,b) logical AND (1 or 0)
angle(x) angle of vector
acos(a) arc cosine
asin(a) arc sine
atan(a) arc tangent
atan2(a,b) arc tangent of a/b
ceil(a) ceiling
cos(a) cosine

exp(a) exponential (ea)
floor(a) floor
if(a,b,c) if a then b else c
ln(a) logarithm (base e)
log(a) logarithm (base 10)
mag(x) vector magnitude
max(a,b) maximum of a, b
min(a,b) minimum of a, b
mod(a,b) remainder of a/b
not(a) logical NOT (1 or 0)
or(a,b) logical OR (1 or 0)
pi() constant π
pow(a,b) power (ab)
rand() random (between 0..1)
sign(a) sign (1 or -1)
sin(a) sine

sqr(a) squared (a2)
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sqr(x) vector 2-norm (|x|2)
sqrt(a) square root
tan(a) tangent
vector(a,b) creates 2-vector

Simulation Functions

Simulation functions are used to extract data from the simulation. 
These functions are used in the various meters and vectors of 
Working Model.

Name Inputs Output

constraintforce number vector
number,number vector
number,number,number vector

frame number
frictionforce number,number vector
groupcofm number vector
kinetic number
length number,number number
normalforce number,number vector
section number,vector number


